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Equilibrium of a Body
Chapter 1
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Engineering Statics
In Engineering Statics, we study the forces among rigid bodies at rest.
� Since the bodies are not moving, the forces must satisfy Newton's equations of static equilibrium.  The static 
equilibrium equations must be satisfied for a single body, a group of bodies in the system, or the entire bodies system.  It 
is fair to say that Engineering Statics is the study of the static equilibrium equations and their application.
� In "solving" a structural problem, we mean finding the forces acting on each structural member.  In many cases, static 
equilibrium equations are enough to solve the problems.  In these cases, we called these problems statically 
determinate problems.  In other cases, we may need to seek other conditions, such as deformation conditions, to
solve the problems.  In these cases, we called these problems statically indeterminate problems.  In Engineering
Statics, we study statically determinate problems only.

Rigid Body Assumption
In the real world, all solid bodies are more or less deformable.  There are no such things as rigid bodies.  However, if
the deformation of a body is not our concern and if the deformation is negligible, we can treat the body as a rigid 
body.  In Engineering Statics, we assume all bodies studied in this book are rigid bodies.  If deformation needs to be
considered, we'll use a spring to represent a body.  In Engineering Statics, springs are the only elements that are 
deformable.
� Rigid body assumption might introduce errors.  However, in many cases, the errors are negligible.  In statically 
determinate problems, rigid body assumption usually introduce negligible errors.
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1.1-1  Introduction

 A  B
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 1 
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 1  
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[1] In this section, we consider a block [2] supported 
by a hinge [3] and a roller [4] and find the reaction 
forces at the supports.  Before we proceed to solve 
the problem using SOLIDWORKS, let's manually
calculate the reaction forces.
� From the free-body diagram [5], taking the 
moment equilibrium about A, we have

�   M
A∑ = 0

�   (150 N)(1 m)+ (300 N)(0.5 m)− B
Y
(1.5 m) = 0

�   BY
= 200 N

Force equilibrium in Y direction,

�
  F

Y∑ = 0

�   AY
+ B

Y
− (300 N) = 0   (where   BY

= 200 N)

�
  AY

=100 N

Finally, force equilibrium in X direction,

�
  F

X∑ = 0

�   AX
+ (150 N) = 0

�   AX
= −150 N

Note that the negative sign of 
 AX

 indicates that it is
opposite to the assumed direction shown in [5].  
Now, let's solve this problem with SOLIDWORKS.  
If you know how to solve a simple problem like this, 
you may be able to solve a much more complicated 
problem.

[3] The block has a 
hinge support at the 

lower-left edge.

[4] The block has a 
roller support at the 

lower-right edge.

[5] This is a 
free-body 

diagram of the 
block. #

[2] The block has a 
thickness of 0.2 m.

Section 1.1
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1.1-2  Launch SOLIDWORKS and Create a New Part

About the Textboxes
1. Within each subsection (e.g., 1.1-2), textboxes are ordered with numbers, each of which is enclosed by a pair of
square brackets (e.g., [1]).  When you read the contents of a subsection, please follow the order of the textboxes.
2. The textbox numbers are also used as reference numbers.  Inside a subsection, we simply refer to a textbox by its
number (e.g., [1]).  From other subsections, we refer to a textbox by its subsection identifier and the textbox number 
(e.g., 1.1-2[1]).
3. A textbox is either round-cornered (e.g., [1, 3, 5]) or sharp-cornered (e.g., [2, 4]).  A round-cornered textbox
indicates that mouse or keyboard actions are needed in that step.  A sharp-cornered textbox is used for
commentary only; i.e., mouse or keyboard actions are not needed in that step.
4. A symbol # is used to indicate the last textbox of a subsection [5], so that you don't leave out any textboxes.

SOLIDWORKS Terms
In this book, terms used in the SOLIDWORKS are boldfaced (e.g., Part in [4, 5]) to facilitate the readability.

[3] Click New to create
a new document.

[4] Part is selected
by default.

[5] Click OK to
create a Part 
document. #

[1] Launch 
SOLIDWORKS.[2] User Interface.
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1.1-3  Set Up Unit System 

[2] The unit system 
also can be 

selected here.

[4] Click OK. #

[3] By default, the length 
unit has two decimal places.

[1] The unit system appears 
here.  Click it and select 
MKS as the unit system.

Click it again and select Edit 
Document Units...
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1.1-4  Create a Part: Block

[2] Draw a rectangle 
(using Corner 

Rectangle tool) 
like this.

[1] In the Features Tree 
(also called Part Tree in this 
book), right-click Front plane 
and select Sketch from the 

context menu.

[3] In the Features 
toolbar, click Extruded 

Boss/Base.

[4] Type 0.2 (m) 
for Depth.

[5] Click OK. #
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1.1-5  Create Two Points on the Block

[1] Right-click this 
face and select 

Sketch.

[2] In the Standard 
Views toolbar, click

Normal To.

[3] In Sketch toolbar, 
select Point.

[4] Create a Point on
the middle of this edge.

[5] Create a second Point like this. 
Impose a Horizontal relation

between the two Points.

[9] Click Save and save the document with
the name Block.  A file Block.SLDPRT is

created in your working folder.

[10] This is the Features Tree. 
In this book, we also call it a Part 

Tree. #

[6] Click Exit 
Sketch.

[7] Click Trimetric.

[8] The two Points will be
used to locate the applied 

forces.
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1.1-6  Create an Assembly: BlockSupported

[1] Click New.

[3] Click OK.

[2] Select 
Assembly.

[4] In the Head-Up 
toolbar, turn on 
View Origins.

[5] This is the assembly's Origin.  We 
want to show you how to insert the 
Block so that the part's coordinate 

system is coincident with the assembly's 
coordinate system, which we also refer 

to as the global coordinate system.

[6] In the Begin 
Assembly box, select 

Block.

[7] Click the global 
Origin.  Now the part is 
fixed in the space and its 

coordinate system is 
coincident with the global 

coordinate system.

[8] Select MKS for the unit 
system with default decimal 
places. (1.1-3[1-4], page 7).
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[9] Click Save and save the document
with the name BlockSupported.  A
file BlockSupported.SLDASM is

created in your working folder.

[10] This is the Features Tree of the Assembly. 
In this book, we simply call it an Assembly Tree.

[11] An (f) sign indicates that the Block is fixed in
the space.  Now, right-click it and select Float.

[13] Left-click-drag the 
body to move it around 

the space.

[14] This is the 
part's Origin.

[15] Now, the global Origin
may not be coincident with the 

part's Origin.

[16] Using Move Component>Rotate 
Component tool, you even can freely

rotate the body. #

[12] The (f) sign changes to (-), indicating that the
Block is no more fixed.  We'll show that it can be
moved freely [13-16].  In 1.1-7 (next page), we'll set 

up constraints to fully support the Block.
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1.1-7  Set Up Supports
[1] In the Assembly 
toolbar, click Mate.[2] In the Graphics 

Area, expand the
Assembly Tree, and
select the assembly's 

(global) Front plane... [3] And select the body's 
back face.  You may need 

to rotate the view.

[4] Coincident mate is
automatically selected.

[11] Click OK.

[6] Now, the body is constrained such that the 
back face is coincident with the global Front
plane.  To verify this, rotate to Top view, and

left-click-drag the body.

[7] Also, rotate to 
Right view, and left-
click-drag the body.

[8] Finally, rotate to 
Front view, and left-
click-drag the body.  

We conclude that the 
body is indeed 

constrained to move 
in XY-space.

[9] Select the global 
Top plane...

[10] And select 
the lower-left 
edge.  You may 
need to rotate 

the view.

[5] Click OK.  Note
that the Mate box

is still open.
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[12] Now, the body is further 
constrained such that the lower-left 

edge is coincident with the global Top
plane.  To verify this, rotate to Front

view, and left-click-drag the body.
[13] Select the 
global Right

plane...

[14] And select the 
lower-left edge 

again.  You may need 
to rotate the view. [15] Click OK.

[17] Select the 
global Top plane...

[18] And select the 
lower-right edge.  
You may need to 
rotate the view.

[19] Click OK.

[20] Now, the body is fully 
constrained (supported).  To 
verify this, rotate to Front
view again, and try to move 
the body.  The body can't be 

moved now.

[21] Click OK again to dismiss
the Mate box.

[22] In the Assembly Tree, expand
Mates and rename the four

Coincident mates like this for
better readability.

[23] Click Save. #

[16] Now, the body is further constrained 
such that the lower-left edge is coincident 
with the global Right plane.  To verify this, 

rotate to Front view, and left-click-drag the 
body.  Now, the body is restricted to rotate 

about the Z-axis.
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1.1-8  Load SOLIDWORKS Motion

[2] If SOLIDWORKS Motion is
highlighted, that means it has already 
been loaded; you may jump to next 

page.  Otherwise, click it to load 
SOLIDWORKS Motion, or...

[5] Also click here so that 
the Motion will be loaded
automatically each time you 
start up SOLIDWORKS. 
In this book, we assume that 
you set up this way so that 

the Motion is loaded
automatically each time you 
start up SOLIDWORKS.

[1] Click SOLIDWORKS 
Add-Ins tab.

[4] And then click 
SOLIDWORKS 

Motion.

[6] Click OK.

[3] Another way to load 
SOLIDWORKS 

Motion is selecting
Tools>Add-Ins...
from Pull-Down 

Menus.

[7] SOLIDWORKS Motion is designed to
solve rigid-body mechanical problems, either static 
or dynamic.  By rigid-body, it means the 
deformations of bodies are neglected.  In 
SOLIDWORKS Motion, a static problem is
treated as a special case (of dynamic problems) in 
which the response is independent of time. # 
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1.1-9  Create a Motion Study

[1] Click Motion Study 1 tab.

[2] Assembly 
Tree.

[3] Motion 
Study Tree.

[4] Motion 
toolbar.

[5] Timeline 
Area.

[6] Time Scale Zoom 
Buttons.  In this book, 
because we only perform 
statics study, in which time 
plays no role, we'll not use 

these buttons.

[8] By default, Animation is the Type of Study. 
It has limited capability for motion simulation.

[9] Select Motion Analysis, which provides full
capability for rigid-body mechanical analysis.  In 
this book, we always select Motion Analysis

as the Type of Study and remember that we'll
actually perform statics analyses. #

[7] You may double-click and change to a 
name that makes more sense to you.  We, 

however,  stick to this default name.
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1.1-10  Set Up Forces [1, 7] In Motion toolbar (1.1-9[4], 
last page), click Force.

[2] Click this 
Point to define

the location of the 
first force.

[3] Click this face to define 
the direction of the force.  

Its outer-normal is taken as 
the force direction.

[4] Click to 
reverse the force 

direction.  Now the 
force direction is 

downward.

[5] Type 300 (N).

[6] Click OK.

[8] Click this 
Point to define

the location of the 
second force.

[9] Click this face to 
define the direction 
of the force.  Rotate 

the view if 
necessary.

[10] Click to 
reverse the 

force 
direction.

[11] Type 150 (N).

[12] Click OK. #
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1.1-11  Calculate Results

[1] Click 
Calculate.

[3] The calculation completes in a few seconds, and the Time Slider proceeds to 
right-most position.  By default, the simulation time is 5 seconds, which is an arbitrarily 
chosen time.  Since the body is fully supported and the forces are constant, the results 
are time independent.  We're in effect performing a static analysis.  One thing you need 

to remember about this Time Slider is that whenever you want to re-define the 
forces, make sure the Time Slider is at the beginning (the left-most position). #

[2] If a Motion Analysis 
Messages window appears, 
close it.  In this book, always 
close this window right after 

calculating results.

1.1-12  View the Results

[1] In Motion toolbar, click 
Results and Plots.

[2] Set up Result like this.

[3] Expand the 
Assembly Tree in the 

Graphics Area and 
select Support in Y at 

Hinge.

[4] Click OK.
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[5] Click No.  In this 
book, always click No if 
this message appears.

[6] In the Motion Study Tree, expand 
Results, click Plot1 twice (not double-

click) and change name to Reaction 
Force in Y at Hinge.

[7] The plot shows that the magnitude of the reaction 
force in Y-direction at the hinge is 100 N, consistent 

with the one calculated in 1.1-1[1] (page 5).  Note that 
the reaction force is constant over time.

[8] Close the 
window.

[9] Repeat steps [1-5] except 
selecting X Component in step 

[2] and Support in X at 
Hinge in step [3], 

[10] In the Motion Study 
Tree, click Plot2 twice and 
change name to Reaction 
Force in X at Hinge.
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[11] The plot shows that the magnitude of the reaction 
force in X-direction at the hinge is -150 N, consistent 

with the one calculated in 1.1-1[1] (page 5).

[12] Close the 
window.

[13] Repeat steps [1-5] 
except selecting 

Support in Y at 
Roller in step [3], 

[14] In the Motion Study 
Tree, click Plot3 twice and 
change name to Reaction 
Force in Y at Roller.

[15] The plot shows that the magnitude of the reaction 
force in Y-direction at the roller is 200 N, consistent 

with the one calculated in 1.1-1[1] (page 5).

[16] Close the 
window. #
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1.1-14  Wrap Up
[1] From the Pull-

Down Menus, click 
Window to see that 
there are two opened 

files: Block and 
BlockSupported.

[3] Click Save all.

[2] From the Pull-Down Menus, Select 
File>Exit to quit SOLIDWORKS.

[4] Click Rebuild and save 
the document. #

1.1-13  Do It Yourself:  Validation of the Results

Do It Yourself
[1] To verify the validity of the results, you may check the force and moment 
equilibria for the body.  In a 2D problem like this, you need to check 3 equilibrium 
equations to conclude the validity of the results.  Of course, the 3 equilibrium 
equations must be independent. #



 D
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1.2-1  Introduction

 X

 Y

 Z  C

 B A

[3] The plate is 
supported at D in all 

three directions.

 DX

 DY

 DZ

 BX
 BZ

 CY

[4] The plate is 
supported at B 

in X- and Z-
directions.

  P =
200 N

 2 cm

 9
 c

m

 8 cm

 12 cm

[2] The plate has a 
thickness of 5 mm.

[5] The plate is 
supported at C in Y-

direction.

[6] A force P = 200 N 
is applied at A like 

this. #

[1] Consider an L-shaped plate of thickness 5 mm [2] supported at three corners [3-5] and subject to a force P [6].  
We want to find the reaction forces at the supports.
� There are six reaction force components in this problem, namely  DX

,  DY
,  DZ

,  BX
,  BZ

, and  CY
.  It is possible to establish 

six equations, according to force and moment equilibria, and solve these six reaction forces.  However, we may calculate 

 CY
 directly by considering the moment equilibrium about the axis passing through B and D,

�
  M

BD∑ = 0

�
   

�
λ

BD
⋅ (�r

A B
×
�
P )+
�
λ

BD
⋅ (�r

C D
×
�
C

Y
) = 0

where the unit vector along BD,

�

   

�
λ

BD
=

(−8 cm)
�
i + (−9 cm)

�
j + (12 cm)

�
k

(62 + 92 +122 ) cm
the position vectors,

�
   
�
r
A B

= (−6 cm)
�
i ,  

   
�
r
C D

= (8 cm)
�
i

and the forces,

�    
�
P = (200 N)

�
k,     
�
C

Y
= (C

Y
)
�
j

Substituting these into the moment equilibrium 
equation, and after mild calculation, we have the 
reaction force in Y at C,

�
 CY

=112.5 N� (1)

Supported L-Plate: A 3D Case

Section 1.2
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1.2-2  Start Up and Create a Part: Plate

[2] In the Part Tree, right-click 
Right plane and select Sketch 

(1.1-4[1], page 8).

[1] Launch SOLIDWORKS and click 
New to create a new Part (1.1-2[1-5], 
page 6).  Select MKS unit system with 
three decimal places for the length unit 

(1.1-3[1-4], page 7).

[3] Draw a sketch 
like this.

[4] In the Features 
toolbar, click Extruded 

Boss/Base.

[5] Type 0.08 (m) for 
Depth.

[6] Click OK.

[7] Click Save and save 
the document with the 

name Plate. #
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1.2-3 Create a Point on the Plate

[1] Right-click this 
horizontal face and select 
Sketch (1.1-5[1], page 9).

[2] In the Standard 
Views toolbar, click 

Normal To.

[3] In Sketch toolbar, 
select Point.

[4] Create a Point 
like this.

[8] Click Save. #

[5] Click Exit 
Sketch.

[6] Click Trimetric.

[7] This Point will be used 
to locate the applied force.
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1.2-4  Create an Assembly: PlateSupported

[1] Click New and 
create an Assembly 
(1.1-6[1-3], page 10).

[2] In the Head-Up 
toolbar, turn on 
View Origins.

[5] Select MKS for 
the unit system 

(1.1-3[1], page 7).

[3] In the Begin 
Assembly box, select 

Plate.

[4] Click the global Origin.  
Now the Plate's 

coordinate system is 
coincident with the global 

coordinate system.

[6] Click Save and save the 
document with the name 

PlateSupported.

[7] In the Assembly Tree, Right-click 
Plate and select Float.  The (f) sign changes 

to (-), indicating that the Plate is free to 
move now. #
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1.2-5  Create Planes

[2, 7] In the Assembly 
toolbar, select Reference 

Geometry>Plane.

[1] In the Assembly 
Tree, select Front.

[3] Type 0.12 (m) 
for Distance.

[4] Click OK.  A plane 
parallel to Front plane 
with distance +0.12 m is 

created.

[5] Rename the newly created 
plane as Front12.

[6] Select Right.

[8] Type 0.08 (m) 
for Distance.

[9] Click OK.  A plane 
parallel to Right plane 
with distance +0.08 m is 

created.

[10] Rename the newly 
created plane as Right8.

[11] In the Head-Up toolbar, turn on View 
Planes.  Now the newly created planes are 

shown in Graphics Window. #
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1.2-6  Set Up Supports
[1] In Assembly 

toolbar, click Mate.

[3] Select this vertex again 
and, in Assembly Tree, 
select global Top plane.  

Click OK to create 
Coincident2.  This sets 

up a support at this vertex 
in Y-direction.

[5] Now, try to move the body 
(using left-click-drag).  The 

body is constrained to rotate 
about point D.

[2] Select this vertex (point 
D, see 1.2-1[3], page 21) and, in 

Assembly Tree, select 
global Right plane.  Click OK 
to create Coincident1.  This 
sets up a support at this vertex 

in X-direction.

[4] Select this vertex again and, 
in Assembly Tree, select 

Front12 plane.  Click OK to 
create Coincident3.  This 

sets up a support at this vertex 
in Z-direction.

[6] Select this vertex (point 
B, see 1.2-1[4], page 21) and, in 

Assembly Tree, select 
Right8 plane.  Click OK to 
create Coincident4.  This 

sets up a support at this vertex 
in X-direction.

[7] Select this vertex again 
and, in Assembly Tree, 
select global Front plane.  

Click OK to create 
Coincident5.  This sets up a 

support at this vertex in Z-
direction.

[8] Now, try to move the body 
(using left-click-drag).  The body 
is constrained to rotate about 
the axis passing through BD.
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[9] Select this vertex (point C, see 1.2-1[5], 
page 21) and, in Assembly Tree, select 

global Top plane.  Click OK to create 
Coincident6.  This sets up a support at 
this vertex in Z-direction.  Click OK again 

to dismiss the Mate box.

[10] Now, the body is fully 
supported; it can't be moved.

[12] In the Assembly Tree, expand 
Mates and rename the six 

Coincident mates like this (for 
better readability). #

[11] Turn off View 
Planes.
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1.2-7  Create a Study

[2] Click Motion Study 1 tab 
to create a new Study.

[3] Select Motion Analysis 
(1.1-9[8, 9], page 15). #

[1] Load SOLIDWORKS Motion 
if it is not loaded yet (1.1-8, page 14).

1.2-8 Set Up Forces

[1] In Motion toolbar, click Force.

[2] Click this 
Point to define 

the location of the 
force.

[3] Click this face to define 
the direction of the force.  

Its outer-normal is the 
force direction.

[4] Type 200 (N).

[5] Click OK. #
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1.2-9  Calculate Results [1] Click Calculate.  Remember that, If a Motion 
Analysis Messages window appears, close it. #

1.2-10  Retrieve the Reaction Force at C

[1] In Motion toolbar, click 
Results and Plots.

[2] Set up Result like this.

[3] Expand the Assembly 
Tree in the Graphics 

Area and select Support 
in Y at C.

[4] Click OK.

[5] In the Motion Study 
Tree, Rename Plot1 as 

Reaction Force in Y at C.

[6] The plot shows that the 
reaction force in Y-direction at C is 

+112.5 N, consistent with the 
value in Eq. 1.2-1(1) (page 21).

[7] Close the 
window. #
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1.2-12  Wrap Up

[1] From the Pull-Down 
Menus, click Window to see 
that there are two opened files.

[2] From the Pull-Down Menus, Select 
File>Exit to quit SOLIDWORKS.  Click 
Save all.  Click Rebuild and save the 
document. (See 1.1-14[2-4], page 20) #

1.2-11  Do It Yourself: Other Reaction Forces and 
Validation of the Results

Do It Yourself
[2] To verify the validity of the results, we 
may check the force and moment 
equilibria for the body.  A moment 
equilibrium can be with respect to a 
point or an axis.  You need to check 6 
equilibrium equations to conclude the 
validity of the results.  The 6 equilibrium 
equations must be independent. #

 D

 X

 Y

 Z  C

 B A

 100 N

  P =
200 N

 2 cm

 9
 c

m

 8 cm

 12 cm

112.5 N

112.5 N

 200 N

 100 N

Do It Yourself
[1] It leaves you to retrieve other 
reaction forces.  All reaction forces are 
summarized like this.




